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1 User Guide for PEARL GIS Mapping Site

This document describes how to access and upload data into the ArcGIS online site.
Uploading data into the site requires a file compression/zipping program (e.g. for
shapefiles) and ArcMap 10.1 (e.qg. for rasters).

1.1 Login to ArcGIS Online

PEARL partners can access and sign in to the DHI ArcGIS Online page through
https://www.arcgis.com/home/signin.html|? using login details they have received from
DHI (Please request for login details by writing to Nina at nsd@dhigroup.com).

ArcGIS FEATURES PLANS GALLERY MAP HELP Q

Don't have an account?

Sign up for an ArcG1S subscription Sign In esri
An ArcGIS subscription allows you to set up an online magping portal for your
erganization.
Usemame
Pearl_Users
30-DAY FREE TRIAL
Password
.......... -‘ I

Not ready to subscribe?
Keep me signed in
You can create an ArcGIS Public Account with limits on usage. Note that If you

have an Esri Account then you already have an AreGIS Public Account and you g
can just sign In. SIGN IN

Forgot usemame of p
CREATE A PUBLIC ACCOUNT
Sign in with your enter

Figure 1-1  Sign in page for the site.
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HOME GALLERY MAP GROUPS MY CONTENT MY ORGANIZATION © FEARL ~ Q

There are no itams currently available to display.

Applications
Map Compare App: Swipe Me
Map Compare App: Side-by-Side

Earicom | AcOIS Maketplece | MWelp | Termaof Use | Privacy | Contact Bar | ContsctUs | Report Abuse

Figure 1-2  The site home page.

The homepage for the site is shown after signing in.

1.2 Add Map Data

Add map data from your case study through ‘My Content’ on the Homepage menu.

HOME GALLERY MAP GROUPSH A NTR MY ORGANIZATION © FEARL ~ q

b e

There are no items currently available to display.

Applications
Map Compare App: Swipe Me
Map Compare App: Side-by-Side

Esicom | AreGIS Markatplace | Walp  Terms ofUse | Brvacy | Coetuct Esn | CostsctUs | Rapeet Abuse

Figure 1-3 My Content on the Homepage menu.
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HOME GALLERY MAP GROUPS MY CONTENT MY ORGANIZATION ° PEARL ~ Q
pHi My Content
Foldars + add Item i Create Map @ Create Layer

a Title Tvpe Maoddied Shared

Add and share

Pearl_users (Home)

This is where you can add your maps and apps and share them with others (if you have sharing privileges),
Click + Add item to add your content or click a link below to learn more:

d apps

Figure 1-4  Available folders in the My Content page where data may be kept.

There are several folders where data may be kept. Please use the appropriate folders
for your data and do not use the common ‘Pearl_Users (Home)’ folder.

1.2.1 Add Shapefiles

On your computer, package the shapefile you would like to upload into a *.zip file. Zip
all the files into a zip file with the same name as your *.shp file.

Then, in the ArcGIS Online ‘My Content’ page, click ‘Add Item’ to start uploading data.

+ {'_') ZlCreate Map (#dCreate Layer

Title
Add and share

Type Modified

This is where you can add your maps and apps and share them with others (if you have sharing privileges).
Click 4+ Add item to add your content or click a link below to learn more:

+ Adding your maps and apps

{ Sharing with others

Figure 1-5  Click on ‘Add Item’ to start uploading data.
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Add ltem X

Add an item from your computer or reference an item on the Web.

The item is: On my computer -

File: | Choose File Greve_Buildings.zip
Supported Items

Contents: Shapefile ~

v| Publish this file as a feature layer
(Adds a feature layer item with the same name.)

Title: Greve_Buildings

Tags: Pearl x| |Greve X

ADD ITEM CANCEL

Figure 1-6  The ‘Add Item’ dialog.

Locate the zip file for the shapefile you would like to upload. Click on the ‘Add Item’
button.

Once the data has been successfully uploaded, a description of the added data layer
will appear.

Click on the ‘Share’ option to specify access to the data.

Greve_Buildings

@) Feature Layer (Hosted) by Pearl_Users
Source: Feature Service
/| Last Modified: November 5, 2014

(0 ratings, 1 view)

Bl racebook [T Twitter

* EDIT X DELETE & PUBLISH

Figure 1-7  Click on ‘Share’ to specify how the uploaded data will be shared online.
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Share X

Share the item(s) with:

Everyone (public)
DHI

v| These groups:

| PEARL h |

These settings will replace the current settings.
Bl o

Figure 1-8  Data-sharing options.

HOME GALLERY MAP GROUPS MY CONTENT MY ORGANIZATION © PEARL - Q
pH1 My Content
Foiders + add ttem Fcreats Map Eoreats Laver
- Tithe Type Hodified Shared
MEW il DELETE
B Greve_puildings Shapefile Nov 5, 2014 Group

i Pearl_Users (Home)
=0 3 B Greve_Buildings Feature Layer Nov 5, 2014 Group
i Grave, Denmark
1-20f 2 results
Hamburg, Germany

Saint Ludia

Figure 1-9 The uploaded shapefile placed in the appropriate ‘My Content’ folder.

1.2.2 Upload Rasters

Open ArcMap 10.1 and load the raster file you would like to upload. Set the
symbology/legend for your raster as appropriate. It is not possible to change the
symbology of a raster uploaded to ArcGIS Online as a Map Service.

= = Layers
Max Depth [m]
[10.01 - 0.05
[10.06 - 0.25
[10.26 - 0.50
051 -075
B 0.76 - 1.00
M101-125
B1.26-150
B151-200
201 -3.00
M301-675 I}

Figure 1-10 Symbology set for a raster layer in ArcMap.
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Also, make sure that the raster has a Spatial Reference preferably in UTM system. To
check, right click on the layer in the ArcMap table of contents and select ‘Properties’.
Go to the ‘Source’ tab of the Layer Properties window. Scroll down to see the spatial

reference information.

If the spatial reference is not specified for the raster layer (i.e. shown as ‘Unknown’),
define it through the ArcToolbox ‘Define Projection’ tool. In ArcToolbox, go to ‘Data
Management->Projections and Transformations-> Define Projection’ to launch the tool.
Select the raster as ‘Input’ and choose the appropriate (UTM) coordinate system for

the layer.

Next, sign in to ArcGIS Online from within ArcMap through ‘File=>Sign In’.

Filei Edit View Bookm:a_rks Ins_ert Selection

New...

+ [J

Open...

7]

Save

Save As...
Save A Copy...
Share As

Add Data

Ctrl+N
Ctrl+0
Ctrl+5

¢-v 13
k@

Watersh
o x

ORI

H‘d - ArcGIS Online...

0

J Sign in or out of ArcGIS Online. i

Page and Print S

T

Figure 1-11  Sign-in to ArcGIS Online in ArcMap.

ArcGIS Online Sign In

=

AI‘CG I S Online

ArcGIS Online.

MName:
Pearl_Users

Password:

[ I

[¥] Remember my name
(Forget Me)

Forgot your password?

Get new account

Maps and Apps for Everyone

Enter your username and password to sign in to

/| Remember my password
I_| Sign me in automatically

Trouble Connecting?

Figure 1-12  ArcGIS Online Sign In dialog in ArcMap.

Start uploading/sharing the raster map by going to ‘File>Share As—>Service'.
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Insert Selection Geoprocessing Customize Windows |

RE @CEODEE

Sign Out - Pearl_Users
ArcGIS Online...

Page and Print Setup...
Print Preview...

Print...

Export Map...

Analyze Map...

Map Document Properties...
1 C:\Data\DHI Work\...\Greve.mxd

Y New. CtreN b | 1:35.000 v E@EE
E2 Open.. Ctrl+0 E® 78 2RSS T @ﬂ
@ save Ctrl+S i - _.

Save As... [ N -

Watershed Processing = Attribute Tools » Network
Save A Copy... i
0 w

[ Share As » | Map Package...

Add Data

Service
Publish this map as a service on
the web using either ArcGIS Server
or ArcGIS Online. This command
is disabled if you are currently in
Layout view.

Figure 1-13  Share a raster layer as a ‘Service'.

Select ‘Publish a service’ in the ‘Share as Service’ window and click on ‘Next’.

.
Share as Service

=

N
4
—

[
L

@) Publish a service
() Save a service definition file

() Overwrite an existing service

\

Figure 1-14  Share as Service window.
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(" Publish a Service =)
Choose a connection
My Hosted Services (DHI) ~]
Service name
Greve_T100_Future_Scenario_MaxDepth| I

. — = =}

Figure 1-15 Specify the name for the data you would like to upload under ‘Service name’ in
the ‘Publish a Service’ dialog.

Under ‘Choose a connection’ select the recognized hosted service connection (e.g.
My Hosted Services (DHI). Specify a name for the map under ‘Service name’ and click
on ‘Continue’. Use the name you would like the uploaded data to have in ‘Service
name’.

The ‘Service Editor’ window appears where you can specify different parameters for
the map service being shared. Several items must be filled-in. Go to the ‘ltem
Description’ section. Fill out ‘Summary’ and ‘Tags’.

["Service Editar fom

Connection: My Hosted Services Service Name: ere_‘r1W_F|nu-e_5«nan¢_Mu...: Blmpot o Anslyze dPreview gl Publsh (A

PResmairy Item Description
Capabiibes
Summary (required):
Tud Hagpio Maxmum flood depth for 7100 Future Scenario
Caching i
Advanced Sattings
Tags (requred):
Jion Qesoties peal, Grevel |
Sharng >
Choose Your Tags...
Descripton;
Access and Use Constraints:
Credits:

| Updarte: missing metadata in document based on item description.

Figure 1-16  Fill in the required information in the Service Editor window.
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Go to ‘Caching’ to setup the minimum/maximum visibility scales. Recommended
levels are ‘Counties’ to ‘Building’.

[Teervice Extor N i

|Connecuon: My Hosted Senvices Service Name: erc_nDo_FMum_Scemriu_Mu..I Blwot o Aodvze &l Preview gl Publsh (A

Parameters Caching
Cagabites
Tied Mapping Draw this map service using tles from a cache:
= |
Cachioo || cache settngs
Advanced Settngs =
Tiling Scheme: |mm;hmn;mm '1
Item Description
Levels of Detad
Sharing .
Chocse the minimum and macimum scales for this tled map | mage service. Al levels between the minmum
and masimum scale levels will be cached.
a -
Minimum scale level Maocmum scale level
Level: 9 Level: 18
Scale: 1:1,155,581.108577 Scale: 1:2,256.994353
Buldngs
Estmated Cache Size: nwe Calaulate Cache Sae
% Buld cache automatically when the service is published
! Bulld cache manually after the service is publshed

Figure 1-17 Caching specifications in the Service Editor window.

Go to the ‘Item Description’ section and specify ‘Area of interest to cache’ as ‘Current
extent of the map’.

["service editor . [=50)
1 v
|Connechon: My Hosted Services Service Name: Greve_T100_Future_Scenario_Max. | Blmpot o Anslyze &l Preview (1| Publsh (A
Paramaory Advanced Settings
Clpsbiioes B Enter Scale Enter Pixsi Size
Tied Mapong
Caching —
Advanced Settings | Dt
Item Descripbon
Sharing F
o.o0Me
152874057 o.M -
| 121,155,531, 308577 -
1:2,256.934353 oA
[uum estent of the map. =]
PHG L4 Compression:
I
| Advanced...

e

Figure 1-18 Caching Advanced Settings.

Click on ‘Analyze’ from the Service Editor window menu to check if all requirements
have been satisfied for sharing the map service. Resolve any errors that are reported.
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Advanced s.ﬂingi [ Anabyze anlldenllfy potential performance
18 Enter Scale Enter Piel Size
Add

Scales Pixed Size Duck Space: = Delete
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Figure 1-19  Analyze option on the Service Editor window.

DHI

Finally, click ‘Publish’ from the Service Editor window menu to share/publish the map

service.

[ service Editor

3

un

Connection: My Hosted Services Service Name: Greve_T100_Future Scenario Max..| ] impot o Anshyze i Prevtw .'\'.5} ’
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| Advanced Settings
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Add
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1:577,790.554289 152.874057 o.02M8 -
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%

Figure 1-20  Publish option on the Service Editor window.

You will be notified when the service has been published successfully. Click ‘OK’.
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' E ™
Service Publishing Result =]

e ) Theservice has been published successfully. The cache for the service
' has been enabled and the cache is being generated. Right-click on the

service in the Catalog window to view caching status for your service.

|

=
L.

Figure 1-21  Notification about service publishing.
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Go to the ‘My Content’ page of the ArcGIS Online site. Check that the map service
you have just shared through ArcMap is in the list of contents (root folder first). Move
the newly published Map Service to the proper folder. Modify the sharing settings for
the newly-uploaded map service from the ‘My Content’ page by clicking on ‘Share’

from the menu. Share the data with the organization and/or the group as needed.

1.3 Create Maps

Maps can be created in different ways in ArcGIS online. This user guide focuses on

the options available from the ‘My Content’ page.

In the ‘My Content’ page, click on the ‘Create Map’ button.

Type Modified

= Shapefile Nov 5, 2014
2 Feature Layer fiov 5, 2014

8 Greve_T100_Future_Scenario_MaxDepth Tile Layer Mov 12, 2014
E Greve_T100_Future_Scenario_MaxDepth Service Definition Nov 12, 2014

1 -4 of 4 results

Figure 1-22 Create a map from the ‘My Content’ page.

Follow the instructions shown on the left side of the page to create a new map.
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nome - My Map

[T Dotats | % add ~

BE easemap B save + ® share & print

0 about  [I] Content  |= Legend

It's easy to make youi ovwn imap. Just follow these steps: \

1. Choose an area,
Fan and zoom the map to an area or search by its name or address.

2. Decide what to show.
Chease a §H Basemap then 4 add lavers on top of It

3. Add more to your map.
i add map notas to draw features on the map.

Display descriptive text, images, and charts for map featuresin a 32 pop-up,

4. Save and share your map.

Figure 1-23 Map creation page showing instructions on the left side.

To add content to the map, click on ‘Add’ button. To add content from previously

Qe your map a name and description then share it with other mole.]

A
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uploaded data, select ‘Search for Layers'.

| + Add ~ |: 8B Basemap

Search for Layers

Browse Esri Map Layers
1)

51 Add Layer from Web

n

u
; Add Map Notes

Add Layer from File

cAre

Figure 1-24  Search for layers to add to the map.

Atlantic Ocean

~

AMAZON BASIN

BRAZIL

MNEW MAP

DA

© PEARL -

el

p=f 3

i ¥

KING LN

ot
B Y

{RANCE
ALY ™
srain
e
Wity
ALGERIA Ly
YUY e O
MALL

MIGER
o

MIGIREA

Find layers in ‘My Content’ or your group (PEARL Group) through the dropdown menu

that appears. Click on ‘Go’ to start searching for available layers.
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Search for Layers

Find: |(e.g., parcels, fire...
In: ;PEARL Group
v My Organization

2 Res 11 web
A GIS server
ArcGIS Online

Esri Map Layers

My Favorites
My Content

PEARL GTOUD @

Figure 1-25 Search for layers dropdown menu.
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Available data will appear on the list beside the map. This data will be automatically
filtered depending on the extent of the current map. In the example below, only Greve-

related data appear as the map extent covers Greve.

Search for Layers

Find: |(e.q., parcels, fire...
In: fPEARL Group

vl Within map area
2 Results Found

Greve_Buildings
by Pearl_Users

Greve_T100_Future_Scenario_MaxDepth
%8 by Pearl_Users

Add

Add

Figure 1-26  Available layers shown in the table of contents.

Add the layers you require and click on ‘Done adding layers’ to finish.
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wome - Greve Maps NEW MAP  CREATE PRESENTATION O FEANL =

fm ;;-m.| CRTIRRN | [Tee—

0 ot [T Content | [£ Lagend
Legend

Creve_Buildings

e _T100_Futire_Scemario_MaxGepth
narla_MasDesth 10

o esri

Figure 1-27  Finished map.

When viewing the contents of a map, a drop down menu beside a layer’'s name offers
various options for the layer such as for changing symbols.

Contents ;‘

¢ Greve Buildings [
. @ Zoomto
FI

| [ Transparency
& Greve T100 Futu|
MaxDepth &% SetVisibility Range

(@ Topographic

Rename
Remove

Copy

Hide in Legend

Remove Pop-up

Configure Pop-up

Change ggmggli
Create Labels

Perform Analysis

SR SN T S

P

T EETA AT, Mk - FE T

Show Table

AT WA

Filter

Refresh Interval

Blne @@t

Esri.com . ArcGIS Marketg LR EREERE

Use . Privacy . Contact Esq Save Layer

Figure 1-28 Options for a layer on a map.

Raster and tiled layers cannot be modified and raster symbologies are set follow those
before publishing to ArcGIS Online.

Save the map (‘Save as’) in the appropriate folder.
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Save Map

Title: Greve Midt

Tags: [ P?a;_x _I— xl_

Summary:  [Map of Greve Midt

Save in folder: Greve, Denmark

Figure 1-29  Save Map dialog.
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